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Boards for ET-BASE PX32 Training Board is using a number P8X32A-D40 MCU of PARALLAX. 
MCU is a high sensitivity 32-bit MCU 8 Cog Multiprocessor structure is body-DIP 40 PIN. 
Can run at maximum frequency 80 MHz working pressure 2.7-3.6 VDC development program will use Software tool. 
"Propeller V1.06" Software that can use programming, Compile Code and Download Code via RS232. 
เลย (Debug can not see the work as STEP) The language used in programming language is SPIN, which will help 
Program development easier and faster because the program Propeller Library is used for contact between 
Equipment around the MCU P8X32A with it. This time use the user can call the Library works. 
For example, Library RS232, Library VGA, Library TV, Library Keyboard, Mouse. 
1 Properties of the MCU P8X32A. 
1.1) is the MCU 32 bit 8 Cog Multiprocessor (8 CPU Chip to only). 
1.2), body-DIP 40 PIN-Port I / O 32 Pin. 
1.3), the MCU operates at 2.7-3.6 VDC voltage and I / O Port can drive streams Source / Sink 40 mA at a 3.3 VDC. 
1.4) running at 80 MHz maximum frequency can use External Clock or Internal Clock PLL is within. 
1.5) within the RAM storage for Code 32 Kbyte time, cut out raising MCU Code will be deleted so use real time. 
Must continue the external I2C EEPROM for storage Code. 
1.6) Pin is assigned to work can receive a level Input Voltage Input up to VDD (2.7-3.6V). 
1.7) in a Chip will work inside of the 20 MIPS / cog. 
2 Properties of the Board ET-BASE PX32 V1.0. 
2.1) for MCU P8X32A body-DIP 40 PIN. 
2.2) I2C EEPROM # 24LC256 (32Kb) for storage Code Program. 
2.3), the Board received pressure is set by Input 6-12 VDC Voltage Regulator to adjust it to 3.3V and 5V on board 
2.4) using Crystal 5.00 MHz (External) within the Chip PLL can multiply the increase to higher frequencies up to 80 MHz. 
2.5) program developed by the language used by SPIN Tool "Propeller" (Freeware), Tool is used for programming, 
Compile and Download within the Library and to the Interface between MCU devices around. 
That is on the board. Download Library and can be more. http://www.parallax.com/. 
The language used by SPIN can see the program Help Propeller. 
2.4) Download Download Code via the RS232 can be selected by the Propeller that will Download Code. 
Also stored to EEPROM (External) or RAM within the MCU. 
2.5) this board has allocated I / O Interface for the fixed equipment around: 
1 Port Key Board (PS2), 2. Port Mouse (PS2), 3. Port RS232, 4. Port VGA, 5. Port TV (AV). 
6. Port MIC, 7. Port Headphone, 8. Port I / O 8 PIN for use in other 
ET-BASE PX32 V1.0. 
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3. ไดอะแกรม blog's layout and MCU P8X32A. 
Figure 3.1 shows ไดอะแกรม blog of Chip P8X32A. 
Figure 3.2 shows the structure of Chip P8X32A (DIP 40 PIN). 
From Figure 3.1 that the internal structure of Chip Processor 8 will feature will be called the "Cog" that is. 
Designed to work with high sensitivity. Low power consumption. Body is small. Flexible in working through the Processor. 
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Both the high-8 can work simultaneously at the same time. Independent and articulate, which will use Chip Share resources through 
HUB to the center each Cog Cog can use shared resources. In the system Clock will be to Share. 
Cog Cog each by reference to the same time the base will not be using the Interrupt with Chip, but will use this positioning to 
Jump to working directly with various Cog. 
In Figure 3.2 is a structural body of the DIP 40 PIN Chip with PIN in the classification: 
Table 3.1 details PIN. 
PIN Name Direction Description. 
P0-P31 I / O. 
A Port I / O with Logic level is approximately half the VDD voltage to 1.6 VDC or 3.3 VDC. 
32 Pin to this is with 4 Pin, which will be assigned to special functions or after Power-up Reset. 
P28 - I2C SCL, which will continue to use an external EEPROM. 
P29 - I2C SDA, which will continue to use an external EEPROM. 
P30 - Serial Tx Download Code and used for sending data via RS232. 
P31 - Serial Rx Download Code for the use and receive information through the RS232. 
VDD --- 3.3 V Power (2.7-3.6 VDC). 
VSS --- Ground. 
BOEn I Brown Out Enable (Active Low) will be used to VDD or VSS if legs are legs RESn becomes Low Output. 
But also to Drive Low Reset Chip is a high leg if RESn as the Input. 
RESn I / O Reset (Active Low) on a Chip and Low-Cog are all Disable PIN I / O will be left floating and Chip. 
Restart time is within 50ms after the Logic RESn a change from Low High. 
XI I Crystal Input. 
XO O Crystal Output. 
4 Structure of Board ET-BASE PX32 V1.0. 
For ET-BASE PX32 V1.0 board is set in the Port Interface with specialized equipment around it. 
. In the remaining part of the Port I / O (P0-P7) a 8 Pin is set for users used to other devices. 
More like LED, SW, SD Card, LCD etc. 
Table 4.1 shows the Port to be used on board ET-BASE PX32. 
Port Number page. 
P0-P7 are defined as I / O users can continue to use other more. 
P8-P9 is set to use for the Microphone. 
P10-P11 is set to AUDIO Out Stereo able to expand or a Headphone. 
P12-P15 are set to Port Video Out (NTSC / PAL) for the AV channel of the TV. 
P16-P23 is required for the Port VGA monitor attached to the PC for display or LCD. 
P24-P25 are set to use for the PS / 2 Mouse. 
P26-P27 are set to use for the PS / 2 Key Board. 
P28-P29 [System] is attached to the I2C-EPPROM to collect Code Program (P28: Clock; P29: Data). 
P30-P31 [System] has been assigned to a Port RS232 Download Program to receive and send information. RS232 (P30: Rx; P31: Tx). 
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Figure 4.1 shows the structure of Board ET-BASE PX32 V1.0. 
Number 1: TV (AV-VIDEO) to stem a VIDEO OUT to the TV with a stem attached to the VIDEO IN of TV. 
Number 2: VGA to stem a VGA OUT (DB15) to use for the PC Monitor screen such as LCD. 
Number 3: Headphone AUDIO OUT to a rack for the headphones. Or continue to expand the signal set. 
Number 4: MIC to stem a Microphone. 
Number 5: VIN stem the fire service as a board DC 7V-12 V must be careful to continue. The positive electrode - Delete To correct. 
12.PS/2-Mouse 1.TV (AV-VIDEO) 2.VGA. 
3.Headphone. 
4.MIC. 
5.VIN. 
7.Download/RS232. 
6.I / O Port. 
8.Reset. 
10.PS/2-Keyboard 9.j_Download. 
11.Con 5V. 
13.LED Power. 
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Number 6: I / O Port is a Port I / O 8 Pin set for users to be able to I / O more like any other LCD,. 
Key, LED or SD Card. 
Be careful for I / O Port in this case the Input will be used as a pressure to come to the Port up to VDD or 3.3 V. 
Do not use pressure to 5 V because it allows direct access to Port Pin corruption should be used as an extension of R Divider it to 3.3V. 
Number 7: Download/RS232. Stem is used for the Download Program and to receive communication - sending data via 
The RS232 is a Line Driver Max232 level adjustment signal Rx, Tx from 3.3V to ± 12V. 
To continue with the PC. 
Number 8: Reset the SW. Reset for the operation of the MCU runs at Logic 0. 
Number 9: Jumper Download Download Program To Set jumper to Enable in the Jumper will do that. 
Me RES function of the MCU to the leg stem Download DTR if Set Jumper in the Disable. 
RES MCU's leg is cut from the stem Download DTR legs to prevent Reset signal from PC. 
After the download is complete. It also does not remove the line Download. 
Number 10: PS/2-Keyboard to stem a PS / 2 for the keyboard. 
Number 11: Con 5V per rack is DC 5 V Output for 5 V from the fire board to work outside. 
Number 12: PS/2-Mouse to stem a PS / 2 for the Mouse. 
Number 13: LED Power display jump dart นะ power of work. 
5, use basic programs Propeller. 
5.1) Propeller V1.06 to install on PC 
5.2) after installation and then open the program up to Propeller window as Figure 5.2. 
Figure 5.2. 
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From a window on the right (tab Untitled1) space is used for programming. 
5.3) after programming. Complete it to the File menu, choose Save As to Save File extensions are the spin. 
5.4) when the Save File. Then go to menu and choose Compile Current RUN from the menu that will let users choose to. 
As shown in Figure 5.3, if selected. 
Figure 5.2. 
View Info ... = Compile the program will only Object info and there will be a report of information. 
Write the program in Figure 5.3, which will display RAM area used to display the Clock frequency. 
The use of selected data sample program in Figure 5.3 can be explained is 
- A data file name Ex_TV_Text within this file. Run a Function in the File. 
Library and in the name TV_Text File library TV_Text has run a Function of File library name. 
TV longer one. 
- This file Ex_TV_Text space in RAM to the program and in all 476 Long. 
Guide boards used ET-BASE PX32 V1.0. 
- 8 - www.etteam.com. 
295 Long variable to all the remaining space and RAM available to all 7417 Long by 1. 
Long is 32 bit value equal to or 4 byte. 
- In this program, has selected the Clock Mode mode XTAL1 + PLL16X the Clock Frequency used. 
It would be using Crystal 80 Mhz external 5 MHz (5MHz x PLL16 = 80MHz). 
Object Info window after showing up. Users to select or click on the button Load Ram button Load. 
Download Program EEPROM to choose if the button is Load Load RAM program. 
To keep the area of the MCU RAM, the direct load method. Program will be removed when the press SW. 
Reset the board or remove fire service, if selected button Load Load EEPROM program to be stored. 
EEPROM to the outside before the MCU is to extract the Code to the EEPROM. 
RUN RAM in which to automatically load this program will not be removed when the press SW. Reset? 
Take fire service boards. 
Figure 5.3. 
Load RAM = Compile and Download Program will be in RAM will not show window เลย Object Info. 
To see if a program is deleted, press the SW. Reset or cut service. 
Load EEPROM = Compile and Download Program will be in the EEPROM to the outside will not display. 
Object Info window to see. Program will remain when the Reset or cut service. 
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5.5) Set Baud Rate for COM Port or choose to use the Download Code is not needed because the application. 
Propeller will make Set Baud Rate and Com Port to find automatically. But if users want to set Com Port himself. 
Can be edited by going to Edit menu and select Preferences are a window to select the Operation tab in the box. 
Serial Port Search: Comport, select to use (default = Auto). 
5.6) Propeller this program for the development program will use a language model which SPIN to use the language of SPIN. 
Users can see the command used by the Help menu and then select the Propeller Manual (pdf). 
6 test samples RUN program. 
1) to install the Propeller Tool V1.06.exe order and make an example of the Copy from CD ROM to place ETT. 
In order to PC. 
2) Download the call from a PC Com Port to the stem of the board of Download and Set jumper Download (number 9) 
By the Enable. 
3) We will test the display by the TV so the signal from the TV OUT cable to the board of the stem to VIDEO IN. 
Of TV and then open TV channel in AV detain the power of culture to the board. 
4) from a sample of the ETT into the Folder "Ex1_TV" then select the Folder "Ex1.2_TvText _Graphic". 
Double-click the file. "Ex1.2_TV_TextGPH.spin" Propeller program will open this file. 
5) Then go to the RUN menu and then select the Compile Current Load RAM and then click Load EEPROM or any program. 
Compile and Download are on the MCU. 
6) After loading the program to complete the observation screen TV will see the message "Hello!" Show up at the screen. 
7) To test an example, let other steps that go above With equipment for the Port to continue to use 
Test. 
In addition to examples of writing to the ETT. Users can also test the sample is in the RUN program Propeller. 
Board of ETT with: 
1) Open Propeller comes in the box on the left. See Figure 6.1 in the position to choose the Mouse pointer Propeller Library -. 
Demos will then see a sample file extensions are listed in the SPIN left hand box below. 
2) Double-click the file you want to RUN the sample by selected files will be supported on the Interface with the board of E T. 
T is the sample file to the Port VGA Interface example VGA_DEMO.spin, sample files in Interface Port Mic,. 
Audio example Microphone_to_Headphones.spin, SingingDemoSeven.spin. 
3) Go to RUN and then select the menu and then click Compile Current Load EEPROM Load RAM or the program would have been. 
Download and Compile on the MCU. 
4) observation of the work program. From equipment used to Interface. 
If a user opens the program up to several overlapping windows of the application will Propeller Compile and Download. 
Only part of the program file to be showcasing the Active Screen. 
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Figure 6.1. 
7, the call Download the call and communication RS232. 
- Download Program calls for the call and for sending data between RS232 uses PC boards with calls PX32. 
Line with the same line as Figure 7.1 shows. 
Figure 7.1 shows the call to Download & RS232 communication lines between the board and Px32 PC. 
In the event that will be sending information between RS232 Controller Boards PX32 with other boards can be used to call the show. 
In Figure 7.2. 
Figure 7.2 shows the RS232 lines for sending data between the Controller Board with board PX32. 
- When will be on board Px32 Download Program is to make a call to download via the Connector 5 Pin with 
Stem of the board of the PX32, the Connector DB9 it to the PC Com Port to use the 7.3 and Figure Set. 
Jumper Download (number 9) on the board of the PX32 Enable, when will be sending information through the RS232 board. 
Example program. 
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PX32 with PC or with other board Controller Download program after successfully should be Set Jumper. 
Download (number 9) on the board of the PX32 Disable. 
Figure 7.3 shows a line with Com-Port Download the PC directly. 
If using a PC or Note Book with no stem to the Com-Port will use to convert a set of USB to RS232. 
The first set of conversion if the version of ETT ET-USB/RS232 Mini can to use as shown in Figure 7.4. 
Figure 7.4 shows a line through the converter suite Download ET-USB/RS232 Mini. 
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8 requirement that the developer should know in a language program on SPIN Tool Propeller. 
8.1) for SPIN language we use this time to look into is that Block 6 Block together all the time to write it to print. 
Specific name of each Block are set fixed. Time by typing the name of each Block are requirements that must 
Start typing to Colum. Left of the window used to programming always by the name Block 6 Block: 
1.) CON - Block is configured for use to continue to use variables. This variable can be announced in the Block. 
Ran within the same file, for example. 
2.) VAR - Block this variable will be used for announcements to be used in programming. The variables in Block announced. 
Can run within the same Project File Example 
3.) OBJ - Block is used for the name of the file from outside inwards To be able to run a function in the file. 
The external (non-file from an external file at the Library of the Propeller Run function in the file. 
Users will need to Copy File is the same Project file is written by users) see the function located within the file. 
Library of the Propeller can see in Figure 6.1 Mouse pointer in the box, select "Propeller Library" and then in 
Window below. Will show the file name. Spin out to see which of these files is the File Library Propeller. 
Run with it. Double-click on the File Library files will be opened. And the functions of which it was written. 
Functions those users. Can use the program the user is writing, for example. 
Time will run the function in file Library "tv_terminal" then instead of a term. Functions such as name, 
term.out (12). 
4.) PUB - for Block is for users to write programs that want to go down. And can use the write function. 
In this block within the same or different Project File Project File Project File in every กัน have created. 
Block PUB must be up in at least 1 Block by Block PUB Block Propeller is the first Block. 
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The main program of the next Block PUB Block PUB will be the first look is just a small program. 
For the main program run by Block in this type that then must PUB named to Block PUB. 
With a name like this is that for example the name of the Function. 
Time will be announced within a variable that is put PUB | The name then followed by a variable name. 
Announced that this change will apply only within the PUB and the only variable that will be announced in size 32 bit. 
Time to get value from external functions is also used to put (name of variable 1, variable 2) the name of the internal 
Brackets, then enter the variable name used for passing values into the function. 
Time is passing by value to the external function is to enter: the name of the variable name and then to 
Passing values to the sample. 
In this example the name PUB is Ticks (Pin) is a variable value to be stored external to the 
Pin-change section: Microsecond is a variable used to transmit values and functions from the final 
| Cnt1, cnt2 is a variable within the Block PUB Ticks practice time is announced in the 
Not enough use is required and all announcements. 
5.) PRI - for Block is for users to write programs that need to be different but the same Block PUB where 
Function to write in the Block is looking for a small program run by the same Project File times. 
It can not run a different Project File has announced it will use the same variable Block PUB. 
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6.) DAT - for Block is set for the data table for writing or Assembly Code Example 
Block 6 of this time will be used only to reinforce the user can use the Block has not only need to announce every 
Block and Block each can use the same announcement more than 1 Block by Block PUB in time to reinforce the same name. 
PUB type to the function that must be the same. 
8.2), type the characters that will not type or type variable name. Can print using And uppercase letter 
Small representation within the Propeller with a view to the same variable. Does not look like a different language separate C. 
8.3) times the base number 10 represent more than 3 digits will be always separated by _ such as x: = 1_200. 
8.4) as if the use will be used in Block CON =, If you will use the Block OBJ:, if the Block PUB will be used: =, 
8.5) The number of base Propeller: $ ahead constant like $ 56 to represent numbers using base 16,% ahead at constant (1 and 0) as 
Percent in 1001 to represent the base number 2,%% constant lead (0,1,2,3)%% in 2130 to look like a Quaternary Number is. 
See number 1 is 2-bit core samples from the 2130 = 10% 01% 11 00 (base 2) = 9C (base 16) 
8.6) in the use of commands such as Loop with repeat orders or conditions such as if after typing a command. Part of the program. 
Print the line to come to work under the command repeat or if the skew must type these commands on the right hand. 
1 less if the gap in class type. Or skew to the left is considered the Propeller program in line 
Is an external command or if a repeat example. 
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8.7) in the program will write Comment described by the symbol 'or''then write or Comment on 
Brace (comment) or ((comment)). 
8.8) is used in Block PUB Block main program if the program is written in Block-Open Loop not working. 
Loop Repeat Loop with any program should end with the Repeat command to the MCU Reset to start new programs. 
For more details on this use of language SPIN command to view the program's Help Propeller. 
Visit the Help menu and then select the Propeller Manual (pdf). 
ET-BASE PX32. 
V1.0. 
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Figure cycle ET-BASE PX32 V1.0.

